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Installation and Configuration 

Installing the ICV Software 

 NOTE:  Do not install the USB Security Key until after the Metrics ICV Software is 

installed and the PC is restarted.  The security key requires special drivers that are 

installed with ICV.   

 

The installation program for the Metrics ICV software installs all components 

necessary to run Metrics ICV. You can download the auto-extracting archive 

MTICV-41.EXE from the Metrics Technology website under Downloads link. Be 

sure to save the install file to your local hard disk before running the installation. 

Running the installation from the website will cause an installation error.  You will 

need a valid customer login to enter the Software Downloads area.  

 

NOTE:  You should also download the latest available hot fix release which can be 

found in the same software list and designated MTICV-41-HFXX.EXE where the 

XX is the version of the hot fix. Hot fixes contain resolutions to any reported issues 

and some enhancements that have been added since the initial release of Metrics ICV 

4.1. It is only necessary to apply the latest hot fix to your system since all updates are 

contained in the latest build. Save the hot fix file to your local computer and you will 

be can install it after the base Metrics ICV installation is complete. 

   

Obtain a Codeword 

This codeword is obtained by registering your software with Metrics Technology.  

Please visit our website at www.metricstech.com to register your software and obtain 

the codeword. 

Important Note for upgrading Customers  

The Metrics ICV setup program requires that you backup and uninstall the previous 

version.  To do this, please perform the following steps: 

 

DO NOT LEAVE YOUR BACKUP ARCHIVE IN THE METRICS DIRECTORY!  

COPY THE BACKUP.ZIP FILE TO A DIFFERENT LOCATION LIKE A USB 

DRIVE. 

 

1. Go to the File Menu and select Backup 

http://www.metricstech.com/
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2. Enter the name of the backup ZIP archive in the default directory (i.e. 

C:\METRICS\ICS\backup.zip) 

3. Allow the backup utility to complete then copy the .ZIP file to another 

drive location. 

 

After upgrading, some of the functions of the software will require that older projects 

or features be modified.  A brief list of the modifications are: 

 

Metrics ICS files are now be stored in the windows file system.  Existing tests should 

be opened and then saved in the Metrics\ics\projects directory. 

After upgrading, some of the functions of the software will require that older scripts 

or features be modified.  A complete list of deprecated features is contained in the 

Metrics ICV "Software Migration Guide". 

Procedure to Upgrade ICV from 4.0 to 4.1 

1. Download the Metrics ICV installer MTICV-41.EXE to the hard drive of 

your computer.  

 

2. Select the MTICV-41.exe application icon to start the installation program.  

 

NOTE: The installer may take up to 10 seconds or longer to uninstall the 

previous version of the software before displaying the Welcome panel.  

 

 
 

3. Click Next button on the "Welcome" panel. 
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4. Read the "Software License Agreement" and click the I agree to the terms 

in the License Agreement button to agree to the terms. Then click Next. 

 

 
 

5. Choose "destination location" for installation and click the Next button.  
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 NOTE: It is recommended to select the default C:\Metrics\ as the location to 

 maintain compatibility with previous versions of the software backups.  

 

 
 

6. Click the Install button to begin the Metrics ICV installation. 
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7. The Safenet Sentinel Pro driver installation will now be started to install the 

security license components.  

 

 

 

 
 

8. Select Modify setup type and click the Next button.  

 

 

 

 

 
 

9. Select Custom setup type and click the Next button.  
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10. Click Install to start the Sentinel Driver installation. 

 

 
 

11. Allow the installation to complete. 
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Then click Finish to continue with the Metrics ICS installation. 

 

12. Allow the Metrics ICV installation to complete.  
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Then click Finish to complete the installation. 

 

13. After the installation is finished, re-start the computer.  

 

 
 

14. Connect the USB Security Key to the USB port of your computer. The 

Windows Hardware Manager should detect the USB device as Safenet USB 

SuperPro/UltraPro and should automatically install the driver for the device. 

 

 NOTE: It is recommended the security plug be connected directly to the 

computer instead of through a USB hub or keyboard port if possible.   
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Procedure to Install ICV (new installations) 

1.  Insert the Metrics ICV install CD into the CD-ROM drive of your computer.  

 

2. The CD-ROM should automatically start the Setup.exe installation program.  

If the installation does not start automatically then select right click on the 

CD drive icon in Windows Explorer and then select "explore". Select the 

Setup.exe application icon to start the installation program manually.  

 

The installation will check for any prerequisites and start the Prerequisites 

Wizard to install the necessary software. Please note installation of these 

software components requires acceptance of the 3
rd

 Party license agreements 

displayed during installation. Installation of some components can take 

additional time so you should allow more time for installation if these 

components are not already installed on your workstation PC. 

 

 
 

3. Click Next button on the "Welcome" panel.  
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4. Click Next button on the "Prerequisites" panel.  

 

 
 

5. Click I have read and accept the license terms then click the Install button 

on the "Microsoft .NET Framework" panel.  

 



Installation and Getting Started  14  

 
 

6. Click Finish to continue. 

 

 
 

7. Click I have read and accept the license terms then click the Install button 

on the " Microsoft Visual C++ 2010 Redistributable " panel.  

 



Installation and Getting Started  15  

 
 

8. Click Finish to continue. 

 

 
 

9. Click Next button on the "Welcome" panel. 
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10. Read the "Software License Agreement" and click the I agree to the terms 

in the License Agreement button to agree to the terms. Then click Next. 

 

 
 

11. Choose "destination location" for installation and click the Next button.  
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 Note: It is recommended to select the default C:\Metrics\ as the location to 

 maintain compatibility with previous versions of the software backups.  

 

 
 

12. Click the Install button to begin the Metrics ICV installation. 
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13. The Safenet Sentinel Pro driver installation will now be started to install the 

security license components.  

 

 
 

14. Read the "Software License Agreement" and click the I agree to the terms 

in the License Agreement button to agree to the terms. Then click Next. 

 

 

 

 
 

15. Select Complete setup type and click the Next button.  
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16. Click Install to start the Sentinel Driver installation. 

 

 
 

17. Allow the installation to complete. 
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Then click Finish to continue with the Metrics ICS installation. 

 

18. Allow the Metrics ICV installation to complete.  
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Then click Finish to complete the installation. 

 

19. After the installation is finished, re-start the computer.  

 

 
 

20. Connect the USB Security Key to the USB port of your computer. The 

Windows Hardware Manager should detect the USB device as Safenet USB 

SuperPro/UltraPro and should automatically install the driver for the device. 

 

 Note: It is recommended the security plug be connected directly to the 

computer instead of through a USB hub or keyboard port if possible.   
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Metrics Codewords 

Metrics Technology software products use a combination of a hardware Security 

Key and Codeword. The unique combination of a Codeword and Security Key 

allows the software product to be run on a any workstation PC.  

Software Codeword Information 

There will be a codeword for each software component ordered. This information 

is made up of two (2) parts, the Registration Information and Codeword 

Information. We encourage all customers to register their software with Metrics 

Technology. Only registered users will receive technical support for their products. 

Customer ID 

The Customer ID is a number that has the form IAXXXXXA. Where the X 

is a number. Variations include IHXXXXA, MHXXXXXA, and 

MKXXXXXA. This number must match the number on the Security Key.  

Product Desc 

This is the Product Description. This will be the name of the product, such as 

Metrics ICV or Metrics ICS. 

 Product ID 

The product ID is MTICV or MTICS and should be entered in the ID field  

Version 

This is the version of the software i.e. 4.1.0 

Note: The version number and the codeword are matched. Thus, customers 

who have not purchased an upgrade will not be able to run it without 

purchasing the correct codeword.  

Codeword Serial 

  AYJE6-AKXMP-HXGCK-HMK4R-I2HAB-U3AT6 

  

 Note: The software Codeword Serial number for ICS should be entered in each  

  application (ICV and ICS) separately.  
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To Enter the Metrics ICV Codeword Serial number: 

 
 

1. Start Metrics ICV to display the system window.  

 

2. Open the System Configuration window by selecting Tools » System 

Configuration or click the Config button.  

 

3. Click on the "Software License Codewords" tab  

 

Note: This tab will open automatically if no codewords have ever been 

entered. You will receive a warning message to enter codewords the first time 

you start Metrics ICV. Please follow the instructions below to enter your 

codewords. 
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4. Enter the Product ID, Version, and Codeword supplied on the product 

registration e-mail.  

 

Note: It is recommended that you cut and paste the codeword from the 

registration e-mail sent from Metrics Technology Customer Service. If typing the 

codeword from the keyboard be careful not to transpose letters or numbers. The 

letter I can be confused for the number 1 and the letter O can be mistaken for the 

number 0.  
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5. Click the Set button.  

 

 
 

6. Enter the ICS codeword information. 
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7. Click the Set button.  

 

Note:  You need to enter the ICS codeword again manually in the integrated 

Metrics ICS program. See the information below for performing this important 

step. 

 

 
 

8. Enter the IDE codeword information (optional) only if you have purchased 

this optional product. 

 

9. Click the OK button to close the System Configuration dialog. 
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Entry of the Codeword Serial Number 

The software Codeword Serial number must be manually entered in Metrics ICS. 

  

To Enter the ICS Codeword Serial number: 

1. Open the Metrics ICS program.  Select the menu item Help » Codeword to 

open the Software License Codeword dialog.  

  

   
 

2. Enter the ICS Codeword Serial number supplied on the product registration 

certificate. 

 

3. Click the OK button.  
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Configuring ICV 

 

Probe Station Configuration 

After installing Metrics ICV, it must be configured.  The first time ICV is started, it 

will automatically run the Configuration Wizard Utility. This utility will ask the 

operator a series of questions to determine the correct configuration for the probe 

station drivers of the Metrics ICV software. 

 

Start the Configuration Wizard, follow these steps: 

 

 
 

1. Open the System Configuration window by selecting Tools » System 

Configuration or clicking the Config button.  
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2. Click on the Configuration Wizard button found on the "About 

Information" Tab.  
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3. Select the Probe Station you are using then click Next.  

 

4. Provide the GPIB address of the station then click Finish.  
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Instrument Configuration 

The Configuration Wizard Utility will setup the probe station information, however 

typically other components must also be setup in order to run the testing.  These 

components are setup manually by the user the first time the system is run.  These 

configurations are then saved and automatically loaded each time the software is 

started. 

 

 Instrument Library 

The Metrics ICV Instrument Library contains setup information for the 

instruments used by: 

 The Device Connection Control (Switch Matrix). 

 Instruments used by the Metrics ICV supplied algorithms.   

 Probe Station Control. 
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Switch Matrix Configuration 

Version 4.1 of Metrics ICV has completely integrated the Switch Matrix 

Control within ICV.  Therefore the configuration of a switch matrix is now 

provided within the Metrics ICV System Configuration.   

 

1. Click the Add button to open the Instrument Definition window.  Enter 

the following: 

a. Name- A unique name that identifies the instrument. 

b. Description (optional)- Additional description of the instrument. 

c. Group- Select “Switch” from the pull-down list. 

d. Driver- Select the driver for your instrument from the list. 

e. Physical Interface- Select the GPIB device you will connect to the 

switch matrix through. 

2. Primary Address- Enter the GPIB address of the switch matrix. 
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3. Click the Next button to open the Instrument Configuration window.  

Confirm the instrument is connected to the GPIB bus and click the Poll 

Configuration button. 

 

4. Click the Finish button to complete the addition of the switch matrix. 
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Instrument (SPA, CMU) Configuration 

Metrics ICV Version 4.1 includes a collection of pre-written test algorithms.  

These algorithms control selected CV and IV instruments.  These 

instruments must be configured in this section. 

Note:  The new Agilent B2900 and Keithley 2600 drivers use a new unified 

driver for ICV and ICS. Please refer to the detailed driver manuals for more 

information. If you are using ICS with other drivers you will need to 

configure the instrument in that Tool as well.  

 

1. Click the Add button to open the Instrument Definition window.  

Enter the following: 

a. Name- A unique name that identifies the instrument.  If you 

will be using the ICV algorithms provided by Metrics 

Technology, you MUST name the parameter analyzer “SPA1” 

and the Capacitance Meter “CMU1”. 

b. Description (optional)- Additional description of the 

instrument. 

c. Group- Select “Instrument” from the pull-down list. 

d. Driver- Select the driver for your instrument from the list. 

e. Physical Interface- Select the GPIB device you will connect 

to the switch matrix through. 



Installation and Getting Started  35  

2. Primary Address- Enter the GPIB address of the instrument. 

 

3. Click the Next button to open the Instrument Configuration window.  

Confirm the instrument is connected to the GPIB bus and click the 

Poll Configuration button. 

 

4. Click the Finish button to complete the addition of the instrument. 

 

 

Note:  The communications server includes the driver "Unified 

GPIB" for supporting both legacy GPIB communications and also 

LXI (TCP/IP) communications for instruments that support these 

types of interfaces. The "Unified GPIB" can and should be used to 

communicate with legacy GPIB only instruments. 
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5. Click OK to close the Instrument Library configuration. 
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Introductory Information 

 

Goal of This Manual   

The goal of this manual is provide a process for the user to be able to create a test 

plan with Metrics ICV.  A test plan will be created that tests two devices in the same 

module structure. This plan will be executed across a wafer. The plan will then be 

modified to execute this testing at several sub-die locations within each die. 

 

The definition of the terms wafer, die, module, algorithm, and script will be 

presented to demonstrate how they are used in this product and manual.  In many 

cases certain terminology used within this manual may have a direct correlation to 

another term used within a specific company. 
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Chapter 1- ICV Getting Started Guide 

 

Introduction 

The first chapter of this self-paced "Getting Started Guide" introduces the Metrics 

ICV software. This chapter also provides important information on software versions 

and support. 

 

Please note that each chapter builds upon the information presented in the previous 

chapters. It is recommended that the material is followed in the order presented. 

 

 

Topics Covered 

 What is Metrics ICV Software?  

 Overview of Metrics ICV Software  

 Updating Versions  

 Support  
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What is Metrics ICV Software? 

The Metrics ICV Software is a test executive designed specifically for 

semiconductor characterization and reliability applications. The environment is 

designed to be flexible so that different applications can be designed using the same 

system software.  Customer applications range from incoming parts screening to full 

wafer test. All of this can be accomplished from one software environment while 

being required to write code either minimally or not at all. 

  

Metrics ICV Controls: 

 Semiconductor Parameter Analyzers  

 C-V Meters  

 Switching Matrixes  

 Probe Stations  

 Thermal Ovens and Chucks (with optional Integrated Developer 

Environment) 
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Overview of Metrics ICV Software 

Metrics ICV software allows for the testing to be designed using several 

components. Each component can then be integrated into higher-level components. 

The components are the module script, die script, and wafer plan. 

 

 
 

 

 

The wafer plan sequences the stepping of the probe station to each selected die.  

Once the probe station is at a selected die location, Metrics ICV runs the selected die 

script. 

 

The die script sequences the stepping inside of a die and the module script to be 

executed at the location.  Each location (module) to be visited within the die is listed 

in the die script.  Metrics ICV steps to the Module location and calls the associated 

module script. 

 

The module script allows for the creation and ordering of all tests that occur without 

moving the chuck or removing a part from the fixture. This typically includes the 

changing of switch connections and execution of different tests. 

 

Note:  At run-time the test engineer selects the wafer plan and test script to be run.  

This means that there can be many different die scripts and module scripts and the 

appropriate ones are selected as needed. Each script is stored independently.   
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Determining Software Version 

The software version and Hot Fix number are very important when requesting 

support. Without this information it is impossible to provide efficient service. Please 

be prepared to provide this information when requesting support. 

 

 
 

To determine the software version: 

1. Open the ICV main window. 

2. Select Tools » System Configuration or click the Config button. 

3. Click the "About Information" tab. 
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Updating the Metrics ICV Software 

Please keep your software up to date by downloading and installing the Metrics 

Technology Hot Fixes.  Your software will remind you monthly with a simple 

reminder message to check for updated Hot Fixes.  Often the issues addressed in the 

updates are ones that you may just now be encountering.   

 

Metrics Technology provides Service Patches to registered customers. Once a patch 

has been created and verified by Metrics Technology, it is placed on our web site 

(www.metricstech.com). 

 

The patch can be downloaded from the web site. Please note the patches are very 

large and will take time to download depending upon your connection speed. If you 

have not registered your software,  please do so now to become eligible for software 

updates and support.   

 

Support 

Metrics Technology provides technical support to customers for one year after the 

purchase of the Metrics ICV software.  This support period includes a ninety day 

period when telephone support is available.  The remainder of the year’s support is 

provided by email.  Please refer to the Metrics Technology website 

www.metricstech.com for options available to extend the support period. 

 

All customers who request support must have registered their copy of ICV with 

Metrics Technology. The form is provided as part of the software package or you can 

visit the Metrics Technology web site and select the support link to access the 

registration forms. 

Support is available from Metrics Technology 

Contact Metrics Technology by: 

 Reviewing our web site. 

 Logging in to your account at the Metrics Technology website and 

submitting a support request. 

To receive Technical Support services you will need: 

 Registration Number (Customer ID) 

 Version and Hot Fix Number  

 Complete description of issue, including any error messages  

http://www.metricstech.com/srvpatch.html
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Chapter 2- Starting ICV 

 

Introduction 

The second chapter of this self-paced Guide will cover the 

Metrics ICV toolbar and the functions available.  This chapter 

will also provide an overview of the steps required to create a 

test.  Subsequent chapters will provide the details regarding test 

creation.  

 

Topics Covered: 

 The Metrics Program Group  

 The ICV Toolbar  

 Overview of Test Development 
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The Metrics ICV Program Group 

When Metrics ICV is installed upon the system, a new program group and a desktop 

shortcut is created. The program group is called Metrics and can be found by 

clicking Start -> Programs -> Metrics. Inside the group are several links to different 

pieces of the Metrics ICV software. An example of the desktop shortcut that is 

created is displayed below. This shortcut will open the ICV navigation window. 

 

   

The Metrics ICV Toolbars 

Metrics ICV contains a single toolbar that is used for the creation and execution of 

tests. All of the tasks for creating the test and executing it are accessible from this 

window. 
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Metrics ICV Menus 

The Metrics ICV navigation window has both menus and buttons on it.  The 

menus contain shortcuts to the tools that are used with Metrics ICV.   

Development Menu 

When creating or editing a test, the Development menu is used.  This menu 

includes access to the Device Connections Editor, Algorithms, Module Test 

Editor, Module List Editor, and Die Test Editor.   

Probing Menu 

The Probing Menu contains the applications needed to specify and test the 

wafer prober stepping control.  These include the Wafer Map Editor, Probe 

List Viewer, and Prober Control.   

Testing Menu 

The Testing Menu contains one application, Run Test.  This is the same as 

clicking the Run Test button on the Metrics ICV Toolbar.  This will begin 

the process of running a test. 

Analysis Menu 

The Analysis Menu contains links to both the Data Browser and the Miner 

applications.  The Data Browser allows the viewing of the raw data vectors.  

The Miner allows the creation of wafer maps of a Toolbar for starting them. 

Tools Menu 

The Tools Menu is a collection of applications for the maintenance of the 

system as well as other ancillary applications.  These include Backup and 

Restore utilities, access to the System Configuration, and a link to the 

Metrics ICS tool which can be used to create algorithms. 

Help Menu 

The Help Menu is a direct link to open the online help manual.  The Help 

button on the Metrics ICV Toolbar has the same function. 
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 Metrics ICV Toolbar Buttons 

The Metrics ICV Toolbar Buttons are the shortcuts to controlling and 

viewing test data.   

Run Test Button 

The Run Test button opens a dialogue box that allows the user to select the 

wafer plan, test script, and data location for the execution of a test.   

Probe Control Button 

The Probe Control button opens the Interactive Probe Station Control.  This 

application provides and environment to confirm both that the probe station 

communication is working and the wafer plan setup is correct (die-to-die 

distances and module-to-module distances).   

Plot Browsing Button 

The Plot Browsing button opens an application that allows the plotting of 

data vectors from the wafer data collected. 

Stats Analysis Button 

The Stats Analysis button opens the Miner application.  This application 

provides the capability to create and print histograms and wafer plans for the 

collected data.   

 Help Button 

The Help Button is a direct link to open the online help manual.  The Help 

menu on the Metrics ICV Toolbar has the same function. 
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Test Development in Metrics ICV 

Test Development within Metrics ICV is a process of collecting the appropriate 

components together to perform a wafer test.  These components include a wafer 

plan, module tests, die tests, and test algorithms. 

 

A Top-Down Approach 

When developing a test, a series of decisions are made.  Looking at the 

information required from a top-down approach, the following list of 

questions is answered: 

1. What wafer is to be tested? 

2. What are the die size of the wafer? 

3. What die locations do we want to test? 

4. What module(s) do we want to test within the die?  

5. What test scripts are run at each module? 

6. If testing multiple modules, how far does the probe step to 

move between modules? 

7. What devices do we want to test within the module? 

8. What device pins are connected? 

9. What tests do we want to run on the device? 

10. How do the tests work? 

 

Metrics ICV’s Approach 

By answering these questions, we have a very good idea of how the test 

should run.  But how does this map to the Metrics ICV software?  The 

information below provides a mapping of these functions. 

Metrics Wafer Map Editor 

The Metrics Wafer Map Editor provides the facilities for creating a wafer 

map which stores the information required to answer the questions. 

 What wafer is to be tested? Each map can be named to represent a 

specific wafer and testing pattern. 

 What are the die size of the wafer? Each map contains the X and Y 

die size. 

 What die locations do we want to test?  Each map contains the die 

that are selected to visit. 
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Die Test Editor 

The Die Test Editor is a script generator that allows for the selection of the 

module locations to visit and the module script(s) to execute at the specific 

module. 

 What module(s) do we want to test within the die?  

 What test scripts are run at each module? 

Module Test Editor 

The Module Test Editor is a script generator that sequences the selection of 

devices within a single module and the tests to be run. 

 What devices do we want to test within the module? 

 What tests do we want to run on the device? 

Module List Editor 

The Module List Editor provides the facilities for defining the offset 

distances between modules within a die. 

 If testing multiple modules, how far does the probe step to move 

between modules? 

VB Script Algorithm Editor/ICS 

The VBScript Algorithm Editor and/or Metrics ICS provide the facilities for 

defining the test methodologies for each device. 

 How do the tests work? 

Device Connections Editor 

The Device Connections Editor is a graphical control for the switch matrix.   

 What device pins are connected? 
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Below is a graphical representation of the components and how they relate to one 

another. 

 

 
 

  

 

 



 

Installation and Getting Started  51  

Chapter 3- Creating Device Connections 

 

 

Introduction  

The first step to creating the complete test plan is to configure device connections 

that allow the instrument to connect to the device. This is the case in systems that are 

using switch matrices and probe cards. If your system does not, skip this section and 

omit any switching control from further plan development. 

 

This chapter details how to create device connection files and their use within 

Metrics ICV. The following instructions require that the switch already be 

configured according to the “Switch Matrix Configuration” section of this manual. 

 

  

Topics Covered 

 What is a device connection? 

 Creating device connections  

 Testing the connections  

 Saving the device connection File  
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What is a Device Connection?  

A device connection is the connection path that is made within the switching matrix.  

Typically the SMU or CMU is connected to the Input of the switch matrix.  

Typically the probe card or manipulators are connected to the output of the switch 

matrix.  The device connection is the path that is made between input and output of 

the switch matrix. 
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Creating Device Connections 

Device connections are created within the Device Connection Editor.  The editor is 

accessed by selecting Device Connections Editor in the Development Menu of 

Metrics ICV.  At this point the goal is to create a collection of input/output 

connections that create matrix cross-points on the matrix cards that connect the 

source units with the pins of the device. 

 

  

To Select Input/Output Connections: 

Step 1: Select and name the Connection  

1. Open the Device Connections Editor Development » Device 

Connections Editor or the Connect button. 

 

 

2. Click the Add button to begin the creation of a new Connection. 
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3. Using the File Selection Control,  enter a name for the connection in 

the File name field and click Open.   

Note:  Subdirectories can be created to group switch patterns based 

upon the module they are used within.   

Note: Only switch patterns saved within the Metrics\DevCons 

directory will be saved when using the Metrics ICV Backup utility. 
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4. Select the switch that will be used.    

Note: If only one switch card is configured in the ICV System 

Configuration, then the Select button will be inactive. 

 

5. Click the “o” at the junction of the input and output that corresponds 

to the desired switch path connection.  Alternatively, click the label 

of the input and then the label of the output to mark their intersection. 
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6. Click the Finish button to return to the list of defined device 

connections.  Clicking Finish saves the new switch setting definition. 

7. Click Finish to exit the Device Connections Editor. 
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Testing the Connections 

 After creating a device connection, the Device Connection Editor provides facilities 

for the manual execution of the device connection.  This feature has two primary 

uses: 

 To test the switch path (with a DVM). 

 To allow the execution of an algorithm for debug testing. 

 

The Make Connections Now button sends the commands to the switch matrix for 

closing the selected cross points. The connection pattern remains on the switch card 

until either the power to the switch matrix is switched off or a different set of cross 

points is sent. 

 

 
  

To verify the connections: 

1. Click the Make Connections Now button.  

 

To clear the connections: 

1. Click the Clear Connections Now button.  

 

 

Saving the Switch Connection File 

Unlike previous versions of the Metrics ICV software, version 4.1 automatically 

saves the switch pattern.  Thus there is no need to manually save the device 

connection. 
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Chapter 4- Creating Measurements 

  

 

Introduction 

The next step to creating a test plan is to create the individual measurements. These 

measurements are created within the Metrics ICS software or Visual Basic Script.  

 

This chapter specifically deals with using Metrics ICS to create the measurements.  

The Visual Basic Script editor is described within the IDE - (Integrated Development 

Environment) Reference Manual. 

 

  

Topics Covered 

 What is Metrics ICS Software?  

 Configuring ICS  

 Creating a Sweep Measurement  

 Creating a Spot Measurement  

 Saving the Measurement  

 

 

This chapter introduces the Metrics ICS (Interactive Characterization Software) 

measurement engine and demonstrates how to create measurements with it. Special 

demonstration drivers have been created to allow the development to be independent 

of the instrument. For details about the instrument drivers provided with Metrics 

ICS, please refer to the Metrics ICS documentation. The steps to creating a test 

method will be covered. 

 

Note:  This is not an exhaustive coverage of the Metrics ICS test engine. For a more 

thorough discussion of ICS please refer to the ICS Technical Reference Manual. 
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What is Metrics ICS? 

Metrics ICS (Interactive Characterization Software) is a software application that is 

used by Metrics ICV as a measurement engine. Metrics ICS provides a windows 

based environment for creating measurement using a point and click methodology.  

 

For measurement development the Metrics ICS environment can be used stand-

alone. 

  

Metrics ICS is: 

 Measurement Engine  

 Windows based  

 Point, Click, and Measure  

 Non-automated Applications  

 

Start Metrics ICS by selecting Development >> Algorithm Editors >> ICS menu 

item or click on the ICS button. 
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Configuring Metrics ICS 

Before creating a measurement,  Metrics ICS must know what instrument is being 

used. This is accomplished by configuring the instrument in ICS. Once an instrument 

has been configured, ICS will remember this configuration. The only time ICS must 

be reconfigured is when the instrument is changed or the ICS40.INI file is erased. 

  

 

  

1. Click the "Select Instrument" button. 

2. Highlight the instrument to be added and click the "Connect" button. 

 
 

After the Instrument driver is selected, it must be configured. 

1. Highlight the instrument to be configured and click the Config button. 

2. Enter the GPIB address. 
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Polling an Instrument 

To confirm that the instrument and Metrics ICS are communicating properly,  poll 

the instrument. 

 

1. Click the Poll button. 

2. Click the OK button to close the Configuration window. 

3. Click OK button to close the Instruments window. 
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Create a Sweep Measurement  

The following example demonstrates how to create a sweep measurement using ICS. 

This example uses the demonstration driver within ICS. 

 

To Create a Sweep: 

1. Open the setup editor. 

The Setup Editor is the dialog in Metrics ICS where the measurement is 

configured. It can be opened by clicking the Setup Editor button. 

 

  

 

2. Click "New" to create a new setup 
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3. Name the Measurement Setup. 

Each measurement must have a unique name. Before the measurement can 

be created, it must be given a name. To name the measurement: 

 

a. Click the OK button after entering the name.   

4. Select Source Units. 

The source units correspond to the outputs of the instrument you are using. 

Metrics ICS provides a graphical way to document the connections for later 

reference. To add a source unit:  

 

a. Click on the Sources button to open the Source Units window.  

b. Highlight the specific unit.  

c. Click the blue box beside the device lead in the Setup Editor.  
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  To remove a source unit: 

a. Highlight the attached unit.  

b. Click the blue box beside the device lead in the Setup Editor.  

c. Click the Yes button when asked if "Do you really want to remove the 

source".  

 

 

Note: The graphic is merely a representation of the device. The software 

does not expect behaviors from the data. Thus, the pin-out does not have to 

exactly match, rather it is only for reference.  
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5. Configure Source Units. 

In this example we are creating a sweep source, so we must configure the 

source unit properly. To setup a sweep source: 

 

 

a. Select the stimulus type. 

b. Select the values to be measured (see note below). 

c. Click the blue box beside the device lead in the Setup Editor.  

d. Select the sweep timing (see note below).  

e. Select the Source Mode. In this case we want it to be Sweep.  

Setup the sweep parameters.  

  

Note:  Most SMU's can only measure the signal that is not being sourced. 

Therefore in this case we have selected the Stimulus to be Voltage resulting 

in the Current being measured. The values returned for Voltage in this case 

would be the calculated voltage steps. The opposite is true when the 

Stimulus mode is set to Current. The Sweep Time parameters are to control 

the rate of the sweep. Please note that these inputs vary for different 

instruments. 
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Create a Spot Measurement 

In this example we will create a spot (or single point) measurement. Most of the 

steps are the same or similar to creating a sweep measurement. The first step is to 

open the setup editor. The setup editor can be opened by clicking the Setup Editor 

button. 

 

  

To Create a Spot Measurement: 

1. Open the setup editor. 

The Setup Editor is the place in ICS where the measurement is configured. It 

can be opened by clicking the Setup Editor button. 
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2. Name the Measurement Setup. 

Each measurement must have a unique name. Before the measurement can 

be created, it must be given a name. To name the measurement: 

 

a. Click the New button and type in a name.  

b. Click the OK button after entering the name.  

c. Select Source Units.  

 The source units correspond to the outputs of the instrument you are using. 

Metrics ICS provides a graphical way to document the connections for later 

reference. To add a source unit: 

 

a. Click on the Sources button to open the Source Units window.  
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b. Highlight the specific unit.  

c. Click the blue box beside the device lead in the Setup Editor.  

 

 

To remove a source unit: 

a. Highlight the specific unit.  

b. Click the blue box beside the device lead in the Setup Editor.  

c. Click the Yes button.  

  

Note: The graphic is merely a representation of the device. The software 

does not expect behaviors from the data. Thus, the pin-out does not have to 

exactly match, rather it is only for reference.  
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3. Configure Source Units. 

In this example we are creating a spot source, so we must configure the 

source unit properly. To setup a spot source:  

 

 

a. Select the stimulus type.  

b. Select the values to be measured (see note below).  

c. Select the Source Mode. In this case we want it to be Const.  

d. Setup the source bias.  

  

Note:  Most SMU's can only measure the signal that is not being sourced. 

Therefore in this case we have selected the stimulus to be Voltage resulting 

in the Current being measured. The values returned for Voltage in this case 

would be the calculated voltage steps. The opposite is true when the 

Stimulus mode is set to Current. Please note that these inputs vary for 

different instruments. 
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Executing the Measurement 

The measurement mode is Standard by default. Thus all of the previous 

measurement types (sweep and single point) did not need this value changed. 

 

To access the Measurement Remote control click on the Measure button on the ICS 

toolbar. 

 

 

To Execute a Measurement: 

1. Make sure the measurement name is displayed in this box.  

2. Use the pull down menu to select the Standard mode.  

3. Click the Single button to execute the measurement.  

 This toolbar contains buttons to begin the measurement as well 

as menus to select the measurement and mode.   

 

 At this point the software will communicate with the 

instrument and execute the measurement. 
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Data Return 

Metrics ICS (Interactive Characterization Software) automatically returns the data 

from an executed measurement. The data is presented in a built-in spreadsheet. The 

spreadsheet is automatically created when a test setup is created. It will begin as a 

minimized window in the lower left corner of the ICS window. To view the data 

simply double-click the window that has the same name as the test setup. 
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Saving the Measurement 

The last step to creating measurements is to save them. A measurement or collection 

of measurements is saved in a Project File. To save a project file select Save As ICV 

Algorithm from the File Menu of ICS, select a directory, enter a name, and click the 

OK.  

 

 
 

Note:  Project Files can be saved in any directory.  However if you plan to use the 

test with ICS it MUST BE SAVED IN THE METRICS\ALGS DIRECTORY or a 

sub-directory within the Metrics\algs directory.  
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Chapter 5- Creating a Module Test 

  

 

Introduction 

The next step in creating a test plan is to build a module test script containing the 

ICS algorithms and device connections. The module test designates the order in 

which actions occur during testing of a specific module.  

 

Topics Covered 

 What is a Module? 

 What a Module Test Does  

 Creating a Module Script  
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What is a Module? 

Metrics ICV uses the concept of a Module to define a level of scripting available in 

the design of tests.  At some companies, the module is called a sub-die, quad, or 

TEG.  Metrics ICV uses a definition which is based upon the function and equipment 

of the specific test system it is installed upon. 

A module is all of the devices that the probe needles are able to touch at the same 

time (without moving the probe chuck, needles, or platen). 

 

Below are two examples of modules.  The picture on the left is the case where the 

probe station has a 2x6 probe card.  The probe needles can touch the 12 pads at the 

same time without having to move the probe chuck.   The picture on the right is the 

case where the probe station has 4 discrete positioners and only 4 device pads can be 

contacted at the same time without moving the chuck or positioner. 
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What a Module Test Does 

A module test is a collection of the tests that are to be performed at a specific module 

location.  If the probe system is using a probe card and switch matrix, then the 

module test would control both the setting of the switch matrix (device connection) 

and the running of test algorithms (ICS or VBScript) for any of the devices within 

the module. 

  

 
 

The module test is typically called by a die test script (see next chapter). 
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Creating a Module Test Script 

Module Test Scripts specify and control all of the testing performed without moving 

the wafer chuck. Algorithms can be combined with device connections (Switching), 

If-Then structures, and Variables to create a testing solution. 
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To create a Module Script: 

1. Open the Module Test Editor by selecting Development >>Module 

Test Editor menu item or Test Script button in the Module area of 

the Metrics ICV navigation window. 

 

2. Select a name for the new script and click the Open button. 
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3. Enter a description in the Description Field. 

4. Click the Add Line button.  Select the Connect Device item and 

click the Finish button. 
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5. The Device Connect Sequence wizard will open.  If you wish to run 

the same tests on a series of devices within a module, you can select 

all of those devices from this dialog and setup their order of 

execution. 
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 Click the Add button to begin creating a list of device connections. 

6. Highlight all of the device connections you wish to add to the script 

item. 
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7. Click the Finish button to return to the Device Connection Sequence 

window.   
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8. Highlight any of the connection names that you wish to change the 

order and use the Move Up and Move Down buttons to change the 

order of execution. 
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9. Click the Finish button to save the device connection sequence to the 

module test script. 

 

10. Highlight the END statement and click the Insert Line button to 

begin adding an algorithm to the module test script. 
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11. Select the Execute Algorithm function and click the Finish button. 
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12. Choose the algorithm to run by highlighting the name of the 

algorithm and clicking the Select button.   

 

Note: This window is displaying the contents of the Metrics\algs 

directory. 
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13. In the case of an ICS algorithm, Choose the test from the list and 

click the Select button. 
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14. The next dialog allows the passing of inputs into the test.  In this case 

we will skip this function and just click the Finish button.  Please 

refer to the Metrics ICV Reference Guide for more information about 

mapping input parameters. 

 

15. Save the module test script. 



 

Installation and Getting Started  88  

 

In the example above, all of the testing is performed from within a module 

script. This means that all of the devices being tested are part of the same 

structure and the wafer chuck is not being moved to reposition the wafer 

between tests.  
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Chapter 6- Creating a Module List 

  

 

Introduction 

The next step in creating a test plan is to build a module list.  The module list is a 

collection of the locations of the modules within a die.  All locations are made 

relative to a single reference position.   

 

Note:  If you are not planning to perform sub-die stepping you can skip this chapter 

and Chapter 7. 

 

Topics Covered 

 What is a module list? 

 The coordinate system of the module list  

 Creating a module list 

 Importing a module list  
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What is a Module List? 

A module list is a collection of the modules contained within a specific die reticle.  

The module list contains both the names and positions of the modules within the die.  

The module list is a convenient way to save this information and the list is 

independent of wafer maps.  Thus if you have different stepping plans for the same 

wafer types, you can reuse the information stored in the list. 

A module list contains all of the module locations entered by the operator. Not all 

of the locations must be used during test setup.  
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The Coordinate System of the Module List 

The module list uses a standard X-, Y- coordinate system for the definition of 

distances between modules.  When standing in front of the wafer probe station 

looking down upon the wafer chuck, positive X is to the right and positive Y is away 

from you (Up).   
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If the wafer is rotated 90 degrees, then the X and Y distances transpose.  This must 

be taken into consideration if the wafer is loaded upon the chuck with the notch or 

flat rotated. 
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Creating a Module List 

The module list is created by using the Module List Editor found in the Development 

menu of Metrics ICV.  All distances used in the Module List Editor are in microns.  

In addition the distances are defined as the distance to move from one module to 

another.  This is illustrated in the following diagram: 

 

 
In the above diagram the module named A1 is treated to be the reference location.  

The reference location (0,0) is the location that the wafer MUST be positioned 

to when starting an automated test.  In the case of auto probe stations, the station 

must be programmed to load to this module when the load command is sent to it.  

The location of the reference location is up to the user.  However, the user should not 

change the reference location unless they erase all old maps.  Otherwise the previous 

maps will not function correctly. 
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Based upon the diagram and the coordinate system, the Modules would be defined 

as:  

 

Module Name X Coordinate Y Coordinate 

A1 0 0 

A2 800 0 

A3 1600 0 

B1 0 -150 

B2 800 -150 

B3 1600 -150 

C1 0 -300 

C2 800 -300 

C3 1600 -300 

 

Note that the reference location is ALWAYS defined as 0,0. 
 

To Create a Module List 

1. Open the Module List Editor.  Select Module List Editor from 

the Development menu or click the List button in the Module 

area of the Metrics ICV navigation window. 

 

2. Enter a name for the new module list and click the Open button. 
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3. The Module List Editor will now open. 

 

4. Click the Add button to add a module location. 
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5. Enter the Module Name, X Offset, and Y Offset and click  

Finish. 
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6. The location will be added to the list. 
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7. Repeat steps 4-6 to add more locations. 

 

8. Click the Finish button to save the module list. 
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Importing a Module List 

The Module List Editor is able to import a list of module locations from a .TXT file.  

The file must use one of the following delimiters for the data: comma, space, or tab.  

After each entry must be a carriage return. 

 

If the file contains duplicate entries the duplicates will be ignored.  For the locations 

listed above, the following data formats would be acceptable: 

 

Comma Delimited 

A1,0,0 

A2,800,0 

A3,1600,0 

B1,0,-150 

B2,800,-150 

B3,1600,-150 

C1,0,-300 

C2,800,-300 

C3,1600,-300 

 

Tab Delimited 

A1<Tab>0<Tab>0 

A2<Tab>800<Tab>0 

A3<Tab>1600<Tab>0 

B1<Tab>0<Tab>-150 

B2<Tab>800<Tab>-150 

B3<Tab>1600<Tab>-150 

C1<Tab>0<Tab>-300 

C2<Tab>800<Tab>-300 

C3<Tab>1600<Tab>-300 

 

Space Delimited 

A1 0 0 

A2 800 0 

A3 1600 0 

B1 0 -150 

B2 800 -150 

B3 1600 -150 

C1 0 -300 

C2 800 -300 

C3 1600 -300 
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Chapter 7- Creating a Die Test 

  

 

Introduction 

The next step in creating a test plan is to build a die test script out of the module list 

and module test scripts. The die test designates the order in which actions occur 

during testing of a die.  

 

Topics Covered 

 What is a die? 

 What a die test does  

 Creating a die test sScript  
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What is a Die? 

The definition of a die within Metrics ICV is the repeating unit on a wafer.  All 

stepping inside of this repeating unit is handled by the module list.   

 

 

What a Die Test Does 

A die test is the testing plan for the modules within the die.  The die test directs the 

probe station to step to a specific module and then run the selected module test at 

that location. 
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Creating a Die Test Script 

 The die script coordinates the sub-die stepping of the probe station with the 

execution of module scripts. If testing is to be performed upon only a single module 

per die, then the die test script will only contain a single stepping call. 

 

To Create a Die Test 

1. Open the Die Test Editor from the Development menu or click the Test 

Script button in the Die area of the Metrics ICV navigation window. 

 

2. Type a new file name or open a die script file to edit. 
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3. Enter a Description and then click the Add Line button. 
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4. Select the Navigate Modules item and click the Finish button. 
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5. Select the module list to use and highlight the specific module you want 

to step to by selecting the first module and then using Shift-Click to 

select the last module. 

 



 

Installation and Getting Started  106  

 

6. The script will be updated to show the movement.  Highlight the END 

statement in the script and click the Insert Line button.  
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7. Select the Execute Module Script item and click the Finish button. 
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8. Click the Browse button to open a dialog box to select the module test. 

 

9. Select the module script then click the Open button to select the module 

test script. 
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10. Click the Next button to add the module script to the die test script. 

 

 

11. Repeat the process for all additional modules you wish to test. 
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Chapter 8- Creating Wafer Maps 

 

 

 Introduction 

At this point all of the methods have been defined and it is time to pick the die that 

this testing will be performed upon. 

 

This chapter details the how and what of probing in Metrics ICV. Features of the 

Wafer Map Editor will be demonstrated. Several of the probe stations that Metrics 

ICV supports have their own software, if necessary that software must be configured 

to accept GPIB control.  Metrics ICV does not support using wafer maps within the 

probe station vendor’s software. 

  

 

Topics Covered 

 Creating a probe plan with the Wafer Map Editor 

 Verifying the wafer pap  
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Creating a Probe Plan with the Wafer Map 

Editor 

Metrics Wafer Map Editor is the probing application designed by Metrics 

Technology to control probe stations.  This editor will take information regarding the 

wafer and die size to produce a graphical representation of the wafer.  The die 

locations to be tested along with the reference die and coordinate system can also be 

specified. 

 

The steps to create a probe plan are:  

1. Select Wafer Map Editor from the Probing menu  or click on the 

Map button under the Probe area of the Metrics ICV navigation 

window.  

 

2. Enter a name for the new map and click the Next button.   

Note: All maps must be stored in the Metrics\Wafermaps directory. 
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3. Enter the wafer information.  The Wafer Definition section is 

required.  The Navigation Options allow for the control of the 

stepping direction of the probe station.  Most users leave these as 

default.  The Wafer Center Definition allows the adjustment of the 

wafer drawn by the Wafer Map Editor so that the map more 

accurately reflects the actual wafer.  (see the Technical Reference 

Manual for further discussion of these features).  

 

4. Click the Next button to continue.  
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5. Click the Left mouse button to select the die locations that will be 

tested.  The Right mouse button can be used to un-select a location.  

Click the Next button after selecting the tested die. 
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6. Use the Left mouse button to select the location of the coordinate 

system origin.   

 

7. Click the Next button to continue.   

 

Note: If you are using a fully automatic probe station, make sure 

your Die numbering EXACTLY matches the die numbering on the 

probe station monitor.  
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8. Use the Left mouse button to select the Reference Die.   

 

Note: The Reference Die is the location that the wafer is loaded to.  

If this location is not specified correctly you will not step the wafer 

correctly. 

 

9. Click the Next button and the map will be saved. 

 

10. An existing map can be edited by opening it with the Wafer map 

Editor. 
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Verifying the Wafer Map 

 Testing the probe plan is a simple process in Metrics ICV. It is recommended that 

any new map be tested to avoid long delays while a system collects data you did not 

intend for it to collect.   

 

Testing the wafer map can confirm: 

1. The die size is correct. 

2. The reference die location selected is correct. 

3. The module list distances are correct. 

 

 

The steps to verify a probe plan are: 

1. Make sure you have already loaded the first wafer onto the chuck and 

it is ready to go (aligned, at reference die, etc.). 

2. Make sure your probe station has a defined contact and separation 

height and they are not the same. Typically this is done by clicking a 

Contact and Separate button on the probe station or the probe 

station’s software. 

3. Select the Control button under the Probe area on the Metrics ICV 

navigation window.  

4. Select the wafer map file to test and click the Open button. 
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5. The Interactive Wafer Map Navigation Window will open.   

Note: During this time the map will try to communicate with the 

probe station.  If you receive an error, make sure the probe station is 

ready to perform GPIB communication.   
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6. Select the Module List to be used from the pull-down list. 

 

7. Click the Align Map button and verify that the wafer is over the 

reference die.  Use your microscope or video to check this.  If using a 

semi-automatic probe station, make sure the chuck is moved back to 

contact. 

 

8. Click the OK button when finished. 
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9. The reference die will turn green indicating this is the current 

location of the probe station. 

 

10. Either click the Play button to watch the station step through the 

wafer plan (including module list locations) or double-click the Die 

location you wish to move to.  You can also double click the 

Modules locations on the Module List control to move between the 

sub-site locations. 
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11. Click the Close button to end the verification testing. 

Hint: Before closing the Interactive Wafer Map Navigation, move 

the wafer back to the Reference Die and Reference Module. 
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Chapter 9- Run Test 

  

 

Introduction 

This Chapter demonstrates how to run a test. This section provides information on 

the daily operation of the Metrics ICV system.  

  

 

Topics Covered 

 Getting a Test Started  
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Getting a Test Started 

Test execution is started by clicking the Run button under the Execute area of the 

Metrics ICV navigation window. 

 

 
  

 

Before clicking Run button, one should verify that the following is complete: 

1. A wafer map has been created. 

2. A die test script has been created. 

3. The wafer map has been verified. 

4. The wafer (first wafer for fully automatic stations) is loaded, aligned, and at 

the reference die upon the probe station. 

5. All test hardware is turned on and connected via GPIB to the control PC. 
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To Run a Test: 

1. Click the Run button on the Metrics ICV window. 

2. The Test Execution Setup window will open.  Enter the Process, Lot, 

Wafer, Mask and Operator Information. 

Note: These fields are optional but should be used to identify these 

parameters for the test because they are written to the header in the 

output data file. 

 

3. Click the Browse button next to the Execute Test field.  
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4. Select the Die or Module script to be run. 
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5. Click the Browse button next to the Save Results in: field and select 

the data file to be created. 
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6. Use the Browse button to select the Wafer Map to be run  

 

Note: (if you are doing manual wafer probing select <No Wafer 

processing>).  If you are using a fully automatic probe station with 

only 1 wafer, select the Use Auto Probers as Semi-Auto Probers 

option to prevent the station from unloading the test wafer.  

 

Note: If you are auto-probing you can select the Put data from all 

wafers into one file option to append all the wafer data to on results 

file. Otherwise the suffix _Wafer(Slot#) will be appended to an 

individual file after each wafer is complete. 

 

7. Click the Run button to begin the test. 
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8. If using a wafer map, the Metrics ICV software will prompt the 

operator to verify the Reference position.  Click OK to confirm the 

reference position. 
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9. The Runtime Status Window will open, click the Start button. 
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10. While the test is running, the Wafer Navigation Status Window will 

show the current die that is being tested. 
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11. At the end of the test the Runtime Status Window will provide a Test 

Complete status message. 

 

12.  Click the Close button to end the current test 
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Chapter 10- Data Manipulation 

 

 

Introduction 

This chapter covers the data that was collected in the previous chapter and what can 

be done to it using tools built into Metrics ICV. 

  

 

Topics Covered 

 Where is the cata?  

 Creating a wafer map  

 Exporting data  

 Viewing data curves  
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Where is the Data? 

 The data created by the execution of the Metrics ICV software is saved in the file 

specified by the operator when starting the test. 

  

 
  

The data is saved in tab-delimited ASCII format. 

 

In addition the file contains tags to identify the various levels of data. This 

representation is reasonable to read, but is very desirable for writing post-processing 

macros. 
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Creating a Wafer Map 

 Metrics ICV contains a tool named the Metrics Miner. The Metrics Miner 

application is very useful for the viewing of Wafer Maps and manipulation of data. 

  

 
  

 

This first example will detail how to create a wafer map using Metrics Miner. 

  

The steps to create a probe plan are: 

 

A. Start Metrics Miner  

The Metrics Miner can be started from the Metrics ICV toolbar by clicking 

the Analysis >> Miner menu item or the Stats button under the Analysis 

area of the Metrics ICV navigation window.  
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B. Load Data  

The first step to manipulating the data with Metrics Miner is to load the data 

from the saved data file.  
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1. Click the File | Load Data menu item.  

2. Select the directory containing the data file.  

3. Select the data file.  

4. Click the Open button.  

 

C. Select Parameter to Map  

Once the data has been loaded, subsequent wafer maps or data exports can 

be created without reloading the data.  
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I. Click the View | Wafer Map menu item.  
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II. Select the die locations to map:  

1. Select the Die locations  

2. Click the Next button.  
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III. Select the die script that contains the parameter to map:  

1. Select the Die script  

2. Click the Next button.  
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IV. Select the module that contains the parameter to map:  

1. Select the Module  

2. Click the Next button.  
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V. Select the module script that contains the parameter to map:  

1. Select the Module script  

2. Click the Next button.  
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VI. Select the device whose parameter is to be mapped:  

1. Select the Device  

2. Click the Next button.  
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VII. Select the test algorithm that contains the parameter to map:  

1. Select the test Algorithm  

2. Click the Next button.  
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VIII. Select the parameter to map:  

1. Select the Parameter  

2. Click the Next button.  

 



 

Installation and Getting Started  145  

D. Setup Map Title and Notes  

The wafer map can be given a Title and Notes.  

 

1. Enter a Title for the wafer map.  

2. Enter Notes for the wafer map.  

3. Click the Next button.  

 



 

Installation and Getting Started  146  

E. Setup Bins  

The binning must be set for the wafer map. The values can be binned 

automatically or the user can specify upper and lower bounds along with the 

number of bins.  

 

1. Enter the Bin parameters.  

2. Edit the bin Colors.  

3. Click the Next button.  
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F. Results  

The resulting wafer pap is shown below. This plan can be copied to the 

clipboard and pasted into other programs. In addition the plan can be printed 

directly to a printer.  
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Exporting Data 

The Metrics Miner application is very useful for the viewing of wafer maps and 

manipulation of data. 

  

 

 
  

This example will detail how to export data parameters using Metrics Miner 

  

The steps to export data are: 

 

A. Start Metrics Miner  

The Metrics Miner can be started from Analysis >> Miner menu item or the 

Stats button in the Analysis area of the Metrics ICV navigation window.  
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B. Load Data  

The first step to manipulating the data with Metrics Miner is to load the data 

from the saved data file.  
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1. Click the File | Load Data menu item.  

2. Select the directory containing the data file.  

3. Select the data file.  

4. Click the Open button.  
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C. Select Parameter(s) to Export  

Once the data has been loaded, subsequent wafer maps or data exports can 

be created without reloading the data.  

 

I. Click the File | Export Parameters menu item.  
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II. Give the File a Title and Notes:  

1. Enter a title for the exported data.  

2. Enter notes for the exported data.  

3. Click the Next button.  
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III. Select the Die locations to be exported:  

1. Select the Die locations.  

2. Click the Next button.  
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IV. Select the Die script that contains the parameter(s) to export:  

1. Select the Die Script  

2. Click the Next button.  
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V. Select the Module that contains the parameter(s) to export:  

1. Select the Module  

2. Click the Next button.  
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VI. Select the Module Script that contains the parameter(s) to export:  

1. Select the Module Script  

2. Click the Next button.  
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VII. Select the device whose parameter(s) is to be exported:  

1. Select the Device  

2. Click the Next button.  
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VIII. Select the Test algorithm(s) that contains the parameter(s) to export:  

1. Select the test Algorithm. You can select more than one.  

2. Click the Next button.  
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IX. Select the parameter(s) to export:  

1. Select the Parameter. You can select more than one.  

2. Click the Next button.  
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X. Select the file to save the parameters in:  

1. Select the file directory.  

2. Enter a file name.  

3. Click the Save button.  
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Viewing Data 

 Metrics ICV contains a tool named the Metrics Data Browser. The Data Browser 

application is very useful for the viewing of the data. The data can be represented in 

table or plot form. After defining a plot, it is easy to select other locations and view 

the data. 

  

 
  

 

This example will demonstrate how to view Data Plots using the Metrics Data 

Browser. 

 

 

The steps to view the data are: 

A. Start Metrics Data Browser  

The Metrics Data Browser can be started from the Analysis >> Data 

Browser menu item or the Plot button in the Analysis area of the Metrics 

ICV navigation window.  
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B. Load Data  

The first step to viewing the data with Metrics Data Browser is to load the 

data from the saved data file.  
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1. Click the Browse button.  

2. Select the directory containing the data file.  

3. Select the data file.  

4. Click the Open button.  

 

C. Setup the Plot  

Once the data has been loaded it is ready to be plotted.  
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I. Open the Plot Setup window.  

1. Click the Plot Setup button.  
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II. Provide a Plot title.  

1. Highlight the Title window and enter a title for the plot.  
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III. Setup the X-axis:  

1. Enter a title for the x-axis.  

2. Select the data vector for the x-axis.  
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IV. Setup the Y-axis:  

1. Enter a title for the y-axis.  

2. Select the data vector(s) for the y-axis.  

3. Click the OK button to close the Plot setup window.  
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D. Review Data  

I. Select other die locations to view.  

 

1. Left or Right buttons next to the die location to change sites.  

2. The plot is automatically updated.  
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Chapter 11- System Backup and Restore 

 

 

Introduction 

A new feature of Metrics ICV is the ability to backup and restore the system using 

built-in functions.  This feature is very useful for the rapid backup of a system into a 

single archive file. 

 

  

 

Topics Covered 

 How to backup  

 Special requirements  

 How to restore  
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How to Backup 

The backup feature is designed to be very simple to use.  The process is a simple 

three steps. 

 

 
 

 

Create a Backup: 

1. Select Backup from the Tools menu or the Backup button in the 

System area of the Metrics ICV navigation window. 

2. Select the file name and location for the backup.   

3. Click the Open button. 

4. The Metrics ICV components will be compressed and stored. 
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Special Requirements 

The backup feature is designed to be very simple to use.  In order to make the feature 

as easy to use as possible, the default directories for saving components are backed 

up.  The backup feature does not search for files saved in other locations.  

 

 

Backup Directories 

 Metrics\data 

 Metrics\algs 

 Metrics\ics\projects 

 Metrics\reports 

 Metrics\scripts 

 Metrics\Wafermaps 
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How to Restore 

The restore feature is designed to be very simple to use.  The process is a simple two 

steps.  The restore feature is designed to be used on a complete installation of 

Metrics ICV. 

 

 
 

 

To Restore: 

1. Remove the Metrics ICV software by using the Add/Remove feature 

of Windows (Control Panel)- remove all Metrics components. 

2. Delete the Metrics directory. 

3. Re-install the Metrics ICV software from CD. 

4. Install the most current Hot Fix. 

5. Select Restore from the Tools menu or the Restore button in the 

System area of the Metrics ICV navigation window.  

6. The Metrics ICV components will be un-compressed and restored. 


